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Marblesoft makes no warranties, either expressly or implied, regarding the software 
described in this manual and its suitability to a particular purpose.

In no event shall Marblesoft be liable to anyone for special collateral, incidental or consequen-
tial damages in connection with or arising from the purchase or use of these programs.  
Marblesoft shall not be liable for any claim against the user of these programs by any other 
party.  Marblesoft’s liability shall in no event exceed the price actually paid by the customer 
for the use of the software.

Marblesoft does warrant for one year after purchase of Money Skills by the customer, the 
software shall reasonably conform to the standards defined in this manual.  Marblesoft 
specifically does not warrant that the software will operate uninterrupted or error-free.  The 
sole and exclusive remedy for a failure of the software to perform in accordance with the 
accompanying documentation is for the customer to return the software to Marblesoft and to 
notify Marblesoft in writing of the nonperformance within one year of purchase.  Marblesoft’s 
sole obligation shall be to provide the customer with a performing copy of the software 
within a reasonable time after receiving notification of nonperformance.

Marblesoft reserves the right to make improvements to Money Skills at any time and without 
notice.  Marblesoft reserves the right to provide software upgrades at a reasonable fee.  By 
accepting an upgrade, the customer agrees to destroy all prior copies of the software and 
documentation.  The terms and conditions of this agreement apply to any and all upgrades.

Warranty Disclaimer



Copyright Notice
This manual and the Money Skills programs are copyrighted.  Any reproduction, in whole or 
in part, of this manual or the Money Skills software is prohibited by federal copyright laws, 
including unauthorized electronic reproduction of the Money Skills disk.  The copyright laws 
provide for criminal penalties of up to one year imprisonment and/or a $10,000 fine.

This product is sold for use on a single computer at a single location.  Contact Marblesoft for 
information regarding site licensing.

Money Skills
Copyright © 1984-2005 by Marblesoft, 12301 Central Ave NE, Blaine, MN  55434.
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Introduction
Welcome to Money Skills, an educational program for use on Macintosh and Windows com-
puters.  The program is geared toward pre-school, early elementary and special education 
students.  The skills the students learn are taught with a minimum amount of time on the 
part of the teacher or parent.

Sight and sound help the student learn.  Because each student has individual needs, we’ve 
designed these programs with the flexibility to allow the teacher or parent to tailor the lessons 
to the particular needs of the student.

The program is patient.  It prompts for a response, waits for an answer and then praises the 
student for good work.

However, Money Skills is not a video game.  While it is intended to make learning fun, its 
purpose is not entertainment.  

The graphics are clear and simple.  The student is not rewarded with explosions and flashing 
lights, but rather with a good word from a friendly voice.  The problems addressed by the 
program have been selected by experienced elementary and special education teachers.  

We hope you’ll find Money Skills a useful teaching aid.  We also hope the use of the program 
will be a rewarding experience for your students and children.

Note:  When the term “Early Learning” is used in this manual, it refers to Money Skills or any 
other Early Learning programs by Marblesoft.
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System Requirements
Money Skills requires at least the following minimum system:

Macintosh 

• 64 MB RAM
• 12 MB free RAM to run the application
• 13” color monitor
• CD-ROM drive
• MacOS 9.0.4 or later.

In addition, Marblesoft recommends the following:

• 17” color monitor
• 32-bit color (“Millions” of colors)

To determine your 
system configuration in 
MacOS 9, choose “About 
this Computer” from the 
Finder’s Apple menu.  
A window something 
like the one on the left 
appears:

In this example, we can 
see that we have 320 MB 
RAM, a 180 MB block 
free for the application, 
and MacOS 9.0.4.

In OS X, choose “About this Mac” from the Apple menu.  Click the “More Info...” button to 
bring up the System Profile window.

In this example, we can see that we have 768K of RAM and Mac OS 10.3.6.
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Windows 

• 64 MB RAM
• 13” color monitor
• CD-ROM drive
• Windows 98 or later.

In addition, Marblesoft recommends the following:

• 17” color monitor
• 32-bit color (“Highest” color)

To determine your system configuration 
in Windows 98, right-click on “My 
Computer” on the Windows desktop and 
select “Properties” from the contextual 
menu.  A window something like this one 
appears:

In this example, we can see that we have 
128 MB RAM and Windows 98.

On Windows XP, choose “My Computer” 
from the Start menu.  Click “View System 
Information” to bring up the System Prop-
erties window.  Click the “General” tab.

In this example, we can see that we have 
512 MB RAM and Windows XP.
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Most educational programs display an image of a fixed size, as small as 640 x 480 pixels, 
no matter what size monitor the program is running on.  On large monitors, the program 
“letterboxes” the image, filling the unused portion of the screen with black.

In order to provide the sharpest possible image for your students, Money Skills is optimized 
to fill all monitors up to 1280 x 960 pixels.  That not only means a larger image for the 
student to see, but more pixels, creating a sharper image.  In fact, with Money Skills running 
on a 1280 x 960 monitor, you get 4 times as many pixels as a typical program displaying 
just 640 x 480 pixels.

To get the best possible image, set your monitor to the highest possible resolution that will 
display 16 or 32 bit bit color, up to 1280 x 960.  Money Skills will automatically fill the screen 
with the sharpest possible image.

Macintosh

From the Apple menu, select the Control Panels submenu and choose the “Monitors” control 
panel.  A window something like this one will appear (MacOS 9 version shown here):

Select the highest resolution on the right that allows “Thousands” (16 bit) or “MIllions” 
(32 bit) of colors on the left.  In this case, you can see we have selected 800 x 600 pixels and 
thousands of colors.

About Colors and Monitor Size
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Windows

From the Start menu, select the Settings submenu and choose “Control Panel”.  From inside 
the control panel, double-click on “Display”.  A window like this one will appear:

Click on the “Settings” tab.  Select the 
highest resolution that still allows “High 
(16 bit)” or “Highest (32 bit) color.  In this 
case you can see we have chosen 1152 x 864 
pixels and Highest Color.

Windows XP users:
While Money Skills works in 16-bit color on 
Windows XP, it looks much better in 32 bit 
color.  Don’t use 16 bit color on Windows XP 
unless your monitor will not display 32 bit 
color.
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Installing Money Skills

Macintosh

Before installing or running Money Skills, read the “Read Me First” file on the CD for any 
changes that were made after this manual was finished.  Place the disk into a drive and 
double-click on the “Read Me First” icon. 

To install the software on your hard drive, double-click on the “Money Skills Installer” icon.  
After the splash screen, and the “Read Me First” window, a dialog something like this one 
will appear (MacOS X version shown here):

The installer should automatically open to the “Applications” folder on your hard drive.  You 
can switch to any other folder, but we suggest using the default Applications folder.  Click 
“Choose” to begin installation.

While Money Skills is being extracted, the information 
displays the installer’s progress something like this:  

Finally, when installation is complete, another dialog 
appears.  Click the “Quit” button to finish.

The Money Skills installer creates a folder named “Marblesoft” in the Applications folder, or 
whatever folder you specified.  The Money Skills program is put in that folder.  You can move 
the Marblesoft folder anywhere you like, but it is recommended that you leave Money Skills 
in the Marblesoft folder.  That way, the program and all your student score files can be easily 
found in a single location.  If you like, you can create an alias to Money Skills and place it in 
any convenient location.
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Windows

The Money Skills CD for Windows is an auto-run CD.  When you insert the CD into the drive, 
it should automatically run the installer.  If not, open “My Computer”, open the CD, and run 
the “setup.exe” program.

After a splash screen, you’ll see the “Read Me First” screen.  Please read this file for any 
changes that were made after this manual was finished.  A copy of the “Read Me First” file is 
also included on the CD, so you can read it in the future without having to run the installer.

After the “Read Me First” screen, you’ll see a dialog 
something like this one:

The installer will ask you where you want Money Skills 
to be installed.  The default is to install it inside a folder 
named “Marblesoft” inside your Program Files folder.  
In most cases, you should accept the default location.

Another screen will ask you where to put Money Skills 
in your Start menu.  The default is to put it in a folder 
named “Marblesoft”.  Again, you should accept the 
default in most cases.

Finally, you’ll be given a chance to make a shortcut to 
the program on your desktop, and a chance to launch 
the program automatically once the installer is done.

While Money Skills is being extracted, the information 
displays the installer’s progress something like the one 
shown here:  

Finally, when installation is complete, another dialog 
appears.  Click the “Finish” button to finish.

The Money Skills installer creates a folder named 
“Marblesoft” at the specified location.  The Money 
Skills program is put in that folder.  You can move the 
Marblesoft folder anywhere you like, but it is recom-
mended that you leave Money Skills in the Marblesoft 
folder.  That way, the program and all your student 
score files can be easily found in a single location.  If 
you like, you can create a shortcut to Money Skills and 
place it in any convenient location.

IntelliKeys Overlays

A folder named “IntelliKeys Overlays” will be created inside the Marblesoft folder.  It con-
tains the overlay files required to use Money Skills with an IntelliKeys keyboard.  You can 
print them out using your Overlay Printer application and can send them to the IntelliKeys 
keyboard with Overlay Sender.
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To start Money Skills, double-click on its icon.  Press a key or click the mouse when the title 
screen appears to bring up the main menu.

The first time you run Money Skills, the program creates a preferences file in your system 
folder or registry and creates a folder named “ Student Scores” in the same folder as the 
Money Skills program.  This folder is the folder where you can keep your students’ scores from 
Money Skills or any of Marblesoft’s other Early Learning programs.

Choosing an Activity

Money Skills uses a simple on-screen menu to allow the student to select an activity.  The 
student can select one of the five activities with the mouse or by typing a key from “1” to “5”.  
Alternately, the activities can be selected directly from the Activity menu. 

When you are through with an activity, simply select another activity from the Activity menu 
or press (Mac ⌘-W, Win Ctrl-W) to return to the main menu.  

Setting the Level of Difficulty

Each activity in Money Skills has multiple levels of difficulty.  To change levels, use the Set 
Level submenu in the Activity menu.

“Advance a Level” (Mac ⌘-A, Win Ctrl-A) advances the program one level.

“Back a Level” (Mac ⌘-B, Win Ctrl-B) sends the program back one level.

“Go to Level...” (Mac ⌘-L, Win Ctrl-L) brings up a dialog asking you to select the level 
you want to run.  

Note

Unless noted otherwise, the following sections describe the activities while in the keyboard 
mode.  The activities in the other modes may be slightly different.

Running Money Skills
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Coins and Bills teaches the student to count coins or bills of a single denomination.

On each odd level, a new coin or bill is introduced, and the student is shown how to count 
that denomination.  Then, a number of coins or bills of a that denomination are displayed on 
the screen.  A number key helps the student to count the money.  

On even levels, the student counts without the aid of the number key.

When a correct answer is given, the program displays the answer in the middle of the screen.  
If a wrong answer is given, the answer is shown on screen, the student is corrected and 
given another chance to answer.  After a specified number of wrong answers is given (see 
Program Control - Rate of Advancement), the student is shown the correct answer and 
allowed to try again.

Coins and Bills can be set to use money from the penny up to the $20 bill.  American, Cana-
dian, European, British or Australian money can be used.

Levels of Difficulty

Level  1 Displays a number of pennies (or Australian 5-cent coins) for the student to 
count.  A number key helps the student count by 1 or 5.

 2 Displays the pennies (or Australian 5-cent coins) with no number key.

 3 Uses nickels (or European/British 2-cent or Australian 10-cent coins) with the 
number key.

 4 Nickels (or European/British 2-cent or Australian 10-cent coins) without the 
number key.

 5 Dimes (or European/British 5-cent or Australian 20-cent coins) with key.

 6 Dimes (or European/British 5-cent or Australian 20-cent coins).

 7 Quarters (or European/British 10-cent or Australian 50-cent coins) with key.

 8 Quarters (or European/British 10-cent or Australian 50-cent coins).

 9 Dollar coins (or European/British 20-cent coins) with key.

 10 Dollar coins (or European/British 20-cent coins).

 11 American dollar bills, Canadian/Australian $2 coins or European/British 50-
cent coins with key.

 12 American dollar bills, Canadian/Australian $2 coins or European/British 50-
cent coins.

 13 5-dollar bills or 1-euro/pound coins with key.

 14 5-dollar bills or 1-euro/pound coins.

 15 10-dollar bills or 2-euro/pound coins with key.

Coins and Bills

Level 1

Level 2

Level 14 - scanning on

Level 10 - Canadian money
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 16 10-dollar bills or 2-euro/pound coins.

 17 20-dollar bills or 5-euro/pound bills with key.

 18 20-dollar bills or 5-euro/pound bills.

Levels 19 - 22 are available only when displaying European or British money.

 19 10-euro/pound bills with key.

 20 10-euro/pound bills.

 21 20-euro/pound bills with key.

 22 20-euro/pound bills.

Choosing the Money

Coins and Bills allows you several different options for displaying money.  To choose which 
money options you wish to use, select “Choose Money...”(Mac ⌘-K, Win Ctrl-K) from the 
Activity menu.  You’ll see a dialog box something like the this one (MacOS X version shown 
here):

The American/Canadian/European/British/
Australian radio buttons allow you to specify which 
currency to use.  The heads/tails buttons cause the 
program to display only the head or tail side of all 
money drawn on the screen, or to alternate between 
heads and tails on each coin or bill.

When the “Draw numbers on coins” checkbox is 
on, the program will draw the numeric value on all 
coins.  Always turn this checkbox on when using 
a small monitor where it is difficult to distinguish 
among similar-looking coins.  You can also display 
whether to display the numbers on dollar coins as 
either “100” or “$1”.

The “display cents” option allows you to specify whether values less than $1 are displayed 
with the “cents” sign or with the dollar sign and decimal point.  

The “Say dollars ‘and’ cents” option causes the program to say “1 dollar and 35 cents”, rather 
than the default “1 dollar 35 cents”.  When “Allow zero as an answer” is checked, the pro-
gram will occasionally include problems with no coins or bills (the answer is “0”).

The three European money buttons allow you to change the words the program uses to ver-
bally describe European money.

The “Count by dollars and cents” option causes the program to say “25, 50, 75, 1 dollar” as 
opposed to the default “25, 50, 75, 100” during the introduction of the coins and bills.

The remaining controls in this dialog have no effect on Coins and Bills.

Level 19 - European money

Level 16 - Canadian money



16

Counting Money
Counting Money teaches the student to count coins or bills of mixed denominations.

On the even levels, a number of coins or bills of two different denominations are displayed 
on the screen for the student to count.  On the odd levels, the money can include all 
denominations from the penny up to the maximum value for that level.

When a correct answer is given, the program displays the answer in the middle of the screen.  
If a wrong answer is given, the answer is shown on screen, the student is corrected and 
given another chance to answer.  After a specified number of wrong answers is given (see 
Program Control - Rate of Advancement), the student is shown the correct answer and 
allowed to try again.

Counting Money can be set to use money from the penny up to the $20 bill.  American, Cana-
dian, European, British or Australian money can be used.  

Levels of Difficulty

  American Canadian European/British Australian

Lev 1 Pennies & nickels Pennies & nickels 1 & 2 cent coins 5 & 10 cent coins

 2 Nickels & dimes  Nickels & dimes  2 & 5 cent coins 10 & 20 cent coins

 3 Pennies - dimes  Pennies - dimes  1 - 5 cent coins 5 - 20 cent coins

 4 Dimes & quarters  Dimes & quarters  5 & 10 cent coins 20 & 50 cent coins

 5 Pennies - quarters  Pennies - quarters 1 - 10 cent coins 5 - 50 cent coins

 6 Quarters & $1 coins Quarters & $1 coins 10 & 20 cent coins 50 cent and $1 coins

 7 Pennies - $1 coins  Pennies - $1 coins 1 - 20 cent coins 5 cent - $1 coins

 8 $1 coins & $1 bills $1 and $2 coins 20 & 50 cent coins $1 and $2 coins

 9 Pennies - $1 bills Pennies - $2 coins 1 -  50 cent coins 5 cent - $2 coins

 10 $1 & $5 bills $2 coins & $5 bills 50 cent & €1/£1 coins $2 coins and $5 bills

 11 Pennies - $5 bills Pennies - $5 bills 1 cent - €1/£1 coins 5 ct coins - $5 bills

 12 $5 and $10 bills $5 and $10 bills €1 and €2/£2 coins $5 and $10 bills

 13 Pennies - $10 bills Pennies - $10 bills 1 cent - €2/£2 coins 5 ct coins - $10 bills

 14 $10 and $20 bills $10 and $20 bills €2 coins & €5/£5 bills $10 and $20 bills

 15 Pennies - $20 bills Pennies - $20 bills 1 ct coins - €5/£5 bills 5 ct coins - $20 bills

Level 6 - sorted

L 13 - Canadian money

Level 9 - scanning on

Level 1
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Levels 16 - 19 are available only when displaying European/British money.

  American Canadian European/British Australian

 16   €5/£5 and €10/£10 bills

 17   1 cent coins - €10/£10 bills

 18   €10/£10 - €20/£20 bills

 19   1 cent coins - €20/£20 bills

Choosing the Money

Counting Money allows you several different options for displaying money.  To choose which 
money options you wish to use, select “Choose Money...”(Mac ⌘-K, Win Ctrl-K) from the 
Activity menu.  You’ll see a dialog box something like the this one (MacOS X version shown 
here):

The American/Canadian/European/British/
Australian radio buttons allow you to specify which 
currency to use.  The heads/tails buttons cause the 
program to display only the head or tail side of all 
money drawn on the screen, or to alternate between 
heads and tails on each coin or bill.

When the “Draw numbers on coins” checkbox is 
on, the program will draw the numeric value on all 
coins.  Always turn this checkbox on when using 
a small monitor where it is difficult to distinguish 
among similar-looking coins.  You can also display 
whether to display the numbers on dollar coins as 
either “100” or “$1”.

The “display cents” option allows you to specify whether values less than $1 are displayed 
with the “cents” sign or with the dollar sign and decimal point.  

“Sort by denomination” causes all the coins and bills on the screen to be sorted, from highest 
to lowest, to make them easier to count.  When off, the money is sorted randomly.  The “Say 
dollars ‘and’ cents” option causes the program to say “1 dollar and 35 cents”, rather than the 
default “1 dollar 35 cents”.  When “Allow zero as an answer” is checked, the program will 
occasionally include problems with no coins or bills (the answer is “0”).

The three European money buttons allow you to change the words the program uses to ver-
bally describe European money.

The remaining controls in this dialog have no effect on Counting Money.

L 17 - European money
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Making Change
Making Change teaches the student to select the correct number of coins and bills to create 
a specified dollar amount.

The student is presented with a number of coins and bills on the left side of the screen.  A 
dollar amount is displayed on the right.  The student moves the money from the left side of 
the screen to the right, until the correct amount is shown on the right side.

Mouse users can simply click on the money they want to move.  It will automatically move to 
the correct position on the other side of the screen.  When the correct amount is shown on the 
right, they click on the answer to confirm it.

Keyboard users use a large arrow cursor on screen to move the money.  The arrow cursor 
always indicates where keyboard actions will occur.  If the arrow cursor is on a money row 
and is pointing right, pressing the right arrow key will move one coin or bill to the right side.  
Pressing a number will move that number of coins or bills to the right.  If the arrow cursor is 
pointing left, the left arrow and the number keys move the money to the left side.

Pressing the arrow key that is the opposite of the arrow cursor  will cause the arrow to change 
direction.  The up- and down-arrow keys move the arrow cursor up and down on screen.  
Pressing “0” also moves the arrow cursor down a row.

When the student has moved the correct amount of money to the right side, they should use 
the down-arrow or “0” key to move the arrow cursor down to the money amount, then press 
the right or left arrow to signal they are done.  The student may also signal they are done by 
pressing the ENTER key, no matter where the arrow cursor is located.

If a wrong answer is given, the answer is shown on screen, the student is corrected and 
given another chance to answer.  After a specified number of wrong answers is given (see 
Program Control - Rate of Advancement), the student is shown the correct answer and 
allowed to try again.

Levels of Difficulty

Level  1 Displays a number of pennies (or Australian 5-cent coins) on the left with a 
dollar amount on the right.  The student moves the correct number of pen-
nies from left to right.

 2 Displays a number of pennies (or Australian 5-cent coins) and nickels (or 
European/British 2-cent or Australian 10-cent coins) on the left.

 3 Pennies (or Australian 5-cent coins) through dimes (or European/British 
5-cent or Australian 20-cent coins).

 4 Pennies (or Australian 5-cent coins) through quarters (or European/British 
10-cent or Australian 50-cent coins).

 5 Pennies (or Australian 5-cent coins) through dollar (or European/British 
20-cent) coins.

 6 Pennies (or Australian 5-cent coins) through American dollar bills, Canadian 
or Australian $2 coins or European/British 50-cent coins).

 

Level 4 - cents sign off

Level 1 - cents sign on
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 7 Pennies (or Australian 5-cent coins) through $5 bills or €1/£1 coins.

 8 Pennies (or Australian 5-cent coins) through $10 bills or €2/£2 coins.

 9 Pennies (or Australian 5-cent coins) through $20 bills or €5/£5 bills.

Levels 10 and 11 are available only when displaying European/British money.

 10 Pennies through €10/£10 bills.

 11 Pennies through €20/£20 bills.

Choosing the Money

Making Change allows you several different options for displaying money.  To choose which 
money options you wish to use, select “Choose Money...”(Mac ⌘-K, Win Ctrl-K) from the 
Activity menu.  You’ll see a dialog box something like the this one (MacOS X version shown 
here):

The American/Canadian/European/British/
Australian radio buttons allow you to specify which 
currency to use.  The heads/tails buttons cause the 
program to display only the head or tail side of all 
money drawn on the screen, or to alternate between 
heads and tails on each coin or bill.

When the “Draw numbers on coins” checkbox is 
on, the program will draw the numeric value on all 
coins.  Always turn this checkbox on when using 
a small monitor where it is difficult to distinguish 
among similar-looking coins.  You can also display 
whether to display the numbers on dollar coins as 
either “100” or “$1”.

The “display cents” option allows you to specify whether values less than $1 are displayed 
with the “cents” sign or with the dollar sign and decimal point.  

“Sort by denomination” causes all the coins and bills on the screen to be sorted, from highest 
to lowest, to make them easier to count.  When off, the money is sorted randomly.  The “Say 
dollars ‘and’ cents” option causes the program to say “1 dollar and 35 cents”, rather than the 
default “1 dollar 35 cents”.  When “Allow zero as an answer” is checked, the program will 
occasionally include problems with no coins or bills (the answer is “0”).

The three European money buttons allow you to change the words the program uses to ver-
bally describe European money.

The remaining controls in this dialog have no effect on Making Change.

Level 8 - Canadian money

Level 11 - European money
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How Much Change?
How Much Change? teaches the student to select enough coins and bills to make a purchase 
and to determine the correct amount of change

The student is presented with an item to buy on the right side of the screen and a number of 
coins and bills on the left.  The student moves money from the left to the right in the manner 
described for Making Change on page 18, until enough money is given to make the purchase.  

How Much Change? requires the student to give the minimum amount of money necessary 
to make a purchase.  However, it will let the student give extra money in order to simplify 
the change.  For example, if an item costs 98 cents, the program will accept $1.00 or $1.03, 
but not $1.01 or $1.13.

Once the student has given enough money for the purchase, the item is moved to the left and 
the student is given enough money to make change on the right.  The student then moves the 
correct change from the right to the left unless the “Automatically give change” checkbox is 
on (see Choosing the Money on the next page).

Levels of Difficulty

Level  1 Pennies (or Australian 5-cent coins) through dimes (or European/British 
5-cent or Australian 20-cent coins), with toys up to 50¢ (or €,25/£.25).

 2 Pennies (or Australian 5-cent coins) through quarters (or European/British 
10-cent or Australian 50-cent coins), with toys up to $1.25 (or €,50/£.50).

On levels 3 - 7, the program can be set to give only bills or dollar coins when using 
American or Canadian money by turning on the “Only give bills” option (see 
Choosing the Money on the next page).

 3 Pennies (or Australian 5-cent coins) through dollar coins (or European/
British 20-cent coins), with toys up to $5 (or €1/£1).

 4 Pennies (or Australian 5-cent coins) through American dollar bills, Canadian 
or Australian $2 coins or European/British 50-cent coins.  Toys up to $5 
American, $10 Canadian or Australian or €2,50/£2.50.

On levels 5 - 9, the program can be set to give only bills or €1/£1 and €2/£2 coins 
when using European/British money by turning on the “Only give bills” option (see 
Choosing the Money on the next page).

 5 Pennies (or Australian 5-cent coins) through $5 bills or €1/£1 coins.  Toys up 
to $20 or €5/£5.

 6 Nickels or European/British 2-cent or Australian 10-cent coins through $10 
bills or €2/£2 coins.  Toys up to $20 or €10/£10.

 7 Nickels or European/British 2-cent or Australian 10-cent coins through $20 or 
€5/£5 bills.  Toys up to $20/€20/£20.

 8 European/British 2-cent coins through €10/£10 bills.  Toys up to €20/£20.

 9 European/British 2-cent coins through €20/£20 bills.  Toys up to €20/£20.

Level 1 - numbers on coins

Level 4 - bills only

Level 5 - Canadian money

Level 7 - European money
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Choosing the Money

How Much Change? allows you several different options for displaying money.  To choose 
which money options you wish to use, select “Choose Money...”(Mac ⌘-K, Win Ctrl-K) from 
the Activity menu.  You’ll see a dialog box something like the this one (MacOS X version 
shown here):

The American/Canadian/European/British/Australian 
radio buttons allow you to specify which currency to use.  
The heads/tails buttons cause the program to display only 
the head or tail side of all money drawn on the screen, or 
to alternate between heads and tails on each coin or bill.

When the “Draw numbers on coins” checkbox is on, the 
program will draw the numeric value on all coins.  Always 
turn this checkbox on when using a small monitor where 
it is difficult to distinguish among similar-looking coins.  
You can also display whether to display the numbers on 
dollar coins as either “100” or “$1”.

The “display cents” option allows you to specify whether 
values less than $1 are displayed with the “cents” sign or with the dollar sign and decimal 
point.  

“Sort by denomination” causes all the coins and bills on the screen to be sorted, from highest 
to lowest, to make them easier to count.  When off, the money is sorted randomly.  The “Say 
dollars ‘and’ cents” option causes the program to say “1 dollar and 35 cents”, rather than the 
default “1 dollar 35 cents”.  

The three European money buttons allow you to change the words the program uses to ver-
bally describe European money.

When “Restrict prices to 5-cent increments” is checked for Australian money, all the prices 
of the toys will be rounded to 5-cent increments.  When not checked, the prices can be in 
1-cent increments.  In that case, the student must give the correct money to the nearest 5-cent 
increment.

When the “Allow negative numbers” checkbox is on, the student is allowed to give back 
more change than the money given, a silly thing to do, but possible.  When off, the student is 
not allowed to do that.

“Only give bills on higher levels” simplifies the problem by only giving the student bills (or 
$1, $2, €1/£1 or €2/£2 coins) to begin each problem.  This is so you can teach the student to 
just give the money in full dollar, euro or pound increments, such as when the student may 
be incapable of learning to figure exact change, and the goal is to just teach money basics.

When “Automatically give change” is on, the program figures the correct change automati-
cally and gives it back to the student, instead of requiring the student to calculate the correct 
change.  Use this option with the “Only give bills” option to teach the student the minimum 
necessary to successfully make a purchase.

The remaining controls in this dialog have no effect on How Much Change?.
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The Marblesoft Store teaches the student to understand the value of money and some of the 
choices that have to be made when spending it.

For each problem, the student is given one dollar or euro.  To help the student understand the 
concept, 10 dimes are dropped into a piggy bank while the money is counted on screen.  The 
dollar amount indicates the total of the money just given and the amount previously saved 
in the bank (explained below).

The student is shown 9 items, each labeled with a price, that they may purchase.  Some items 
may cost more than the student has in the bank, although there will always be items the 
student can afford.  The student selects the item they want by clicking on it or typing its 
number on the keyboard.  

If the student has enough money for the selected item, the program moves the item into the 
shopping cart.  If the item is too expensive, the student is corrected and given another chance 
to select.  After a specified number of wrong answers is given (see Program Control - Rate of 
Advancement), the student is shown an affordable selection and allowed to try again.

The student can choose to skip a purchase by clicking the “Save” button above the piggy bank 
or typing “0” from the keyboard.  The money is left in the bank and another set of items is 
given with another dollar to spend.  The student may only save the money a certain number 
of times (see Choosing the Money on the next page).  The next time, they are required to 
buy something.

The student can see an inventory of the items purchased by clicking on the shopping cart 
or pressing the space bar.  They can also get a different set of items to purchase by clicking 
on the double-arrow icon.

Levels of Difficulty

Level  1 Ten dimes are dropped in the piggy bank for the student to spend.  9 items 
with values up to $3.00/€3,00/£3.00 are presented for the student to choose.  
(The student can purchase any item by saving the money 3 times).

 2 The sound effect is taken away as the dimes are dropped.  The student can 
still see the money amount increase as each dime is added.  The items for 
purchase range up to $5.00/€5,00/£5.00.

 3 The items for purchase range up to $10.00/€10,00/£10.00.

 4 The items for purchase range up to $19.99/€19,99/£19.99.  The animation of 
the dimes is taken away.  The student can still see the dollar amount change 
as the money is added.

The Marblesoft Store

Level 2 - scanning on

Level 1

Level 4 - European money
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Choosing the Money

The Marblesoft Store allows you several different options for displaying money.  To choose 
which money options you wish to use, select “Choose Money...”(Mac ⌘-K, Win Ctrl-K) from 
the Activity menu.  You’ll see a dialog box something like the this one (MacOS X version 
shown here):

The American/Canadian/European/British/Australian 
radio buttons allow you to specify which currency to use.  
The heads/tails buttons cause the program to display only 
the head or tail side of all money drawn on the screen, or 
to alternate between heads and tails on each coin or bill.

When the “Draw numbers on coins” checkbox is on, the 
program will draw the numeric value on all coins.  Always 
turn this checkbox on when using a small monitor where it 
is difficult to distinguish among similar-looking coins.  

The “display cents” option allows you to specify whether 
values less than $1 are displayed with the “cents” sign or 
with the dollar sign and decimal point.  

“Sort by denomination” causes all the items in the store to be sorted, from highest value to 
lowest, to make it easier for the student to select.  When off, the items are sorted randomly.  
The “Say dollars ‘and’ cents” option causes the program to say “1 dollar and 35 cents”, rather 
than the default “1 dollar 35 cents”.  

The three European money buttons allow you to change the words the program uses to 
verbally describe European money.

When “Restrict prices to 5-cent increments” is checked for Australian money, all the prices in 
the store will be rounded to 5-cent increments.  When not checked, the prices can be in 1-cent 
increments.  In that case, the piggy bank could end up with an unrealistic amount of money; 
that is, not in 5-cent increments.

The number of consecutive saves is the number of times the student can add a dollar or euro 
to the piggy bank without making a purchase.  This discourages hoarding, which is not the 
principle we are trying to teach in this activity!

The “Start with” amount is how much money is put in the piggy bank when the student starts 
the activity.  Increasing this amount is useful when the student is working on higher levels 
and it is too tedious for them to save enough money to remain interested.  In addition, you 
might want to increase the amount for scanning students.

The remaining controls in this dialog have no effect on the Marblesoft Store.
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Input Methods
Money Skills supports a variety of input methods, allowing the teacher to fill each student’s 
individual needs.  You can control the input method by using the Input Options and Scanning 
Options dialogs.

Money Skills has two basic modes of operation, called “Standard” and “Yes/No” (scanning).  
In standard mode, the program accepts input from the keyboard or mouse, or from most 
other input devices, such as the TouchWindow or the IntelliKeys extended keyboard.

In “Yes/No” mode, the program presents problems in a way that the student can answer 
“yes” or “no”.  The student can answer by using a single switch, or by using one switch for 
“yes” and one for “no”.  The program scans all the possible answers, waiting for the student 
to answer “yes” or “no”.

Input Devices
This section describes the input devices supported by Money Skills and how to use them.

Keyboard

The standard keyboard or any alternative keyboard like the BigKeys can be used in either 
standard or yes/no mode.  In standard mode, the student types the answer on the keyboard.  
In yes/no mode, the student presses the spacebar to answer “yes”.  When doing dual-switch 
scanning, the student can also press “y” to answer “yes” and “n” for “no”.

Mouse

In standard mode, the student just clicks the mouse on the answer to select it.  In some cases, 
the program needs a numeric input from the student.  In those cases, a number line is drawn 
at the bottom of the screen.  The student enters numbers by clicking on them in the number 
line.

The “mouse dwell” feature described in Input Options - Mouse Dwell can be used for stu-
dents who can move the mouse, but cannot click it.

In yes/no mode, the student just clicks the mouse to answer “yes”.  There’s no way to answer 
“no” with the mouse, so step scanning should not be used for mouse input, since it requires 
two switches (see Input Methods - Scanning Options).

TouchWindow

When using a TouchWindow, it works exactly like the mouse, as described above.  The 
TouchWindow can be used for either standard or yes/no input.
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IntelliKeys

The IntelliKeys keyboard can be used in either standard or yes/no mode.  Overlay files for 
use with Money Skills are provided in the IntelliKeys Overlays folder inside the Marblesoft 
folder.  The Numbers Overlay is for use in standard mode.  The Yes No Overlay is for use in 
yes/no mode.  The Money Skills Overlay has slightly smaller keys than the Numbers Overlay, 
but includes all 4 arrow keys and an “OK” key, making it easier for the student using Making 
Change or How Much Change?.

To use the IntelliKeys, you must first print the overlay using the Overlay Printer program that 
came with your IntelliKeys.  Then load it into the IntelliKeys keyboard using Overlay Sender.  
Finally, run Money Skills and select the appropriate input mode.

All three overlay files are set up for single switch access through the two ports on the left 
side of the IntelliKeys keyboard.  Connect the “yes” switch to Input 1, and the optional “no” 
switch to Input 2.  This way, you can run all the activities in either standard or yes/no mode 
without ever having to change overlays.

Switches

Money Skills works with any number of single-switch devices.  These are connected in a 
number of ways.  Typically, you will attach them by plugging them into another device like 
an IntelliKeys keyboard or a switch-adapted mouse, or into a dedicated interface device like 
the Don Johnston Switch Interface.

You can either use a single switch or two switches with Money Skills.  With a single switch, 
the student answers “yes” and waits for the program to answer “no”.  With two switches, the 
student answers both “yes” and “no”.

Hook the first switch up to the computer so that it sends a “y” or “1” key, a space character, 
or a mouse click.  For dual-switch input, hook up the second switch so that it sends an 
“n” or a “2”.

If you are connecting the switches through the switch inputs on the IntelliKeys keyboard, 
load the “Yes No” overlay, which is pre-programmed to send a “y” from switch 1 and an 
“n” from switch 2.
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Input Options
To set the input options, select “Input Options...” from the Options menu (Mac ⌘-I, Win 
Ctrl-I).  A dialog like this one (Mac OS X version shown here) will appear.

Input Mode

Use these radio buttons to select either standard or yes/no 
mode.  You can also open the Scanning Options dialog directly 
from here (see Input Methods - Scanning Options).

Number Line

There are two ways to display the number line that is used 
in Coins and Bills and Counting Money for mouse and 
TouchWindow users:  0 through 9 (like they really are) and 1 
through 0 (like on a keyboard).  Click on the radio button to 
select which method you prefer.

 

Mouse Dwell

Mouse dwell is a feature for users who can use a mouse or other pointer device, but cannot 
click the mouse button.  When mouse dwell is on and the mouse is positioned over a click-
able item, a countdown starts for the number of seconds specified.  When the countdown 
reaches 0, the mouse button is automatically clicked.

If the student moves the mouse during the countdown, the countdown stops.  If the mouse is 
stopped again on a clickable item, the countdown starts over.

To click the mouse twice on the same item, like when trying to enter 55 cents using the 
number line, position the mouse on the “5” key.  After the countdown reaches 0, the first 5 
will be entered.  Move the mouse slightly and pause again for the second countdown.
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Scanning Options
The Scanning Options dialog controls how Money Skills scans the screen for single- and dual-
switch users.  To set the scanning options, select “Scanning Options...” from the Options 
menu (Mac ⌘-Y, Win Ctrl-Y).  You will be presented with a dialog box looking like the one 
shown here (Mac version shown).

The scanning options are described below:

Scanning On

Turning on the “Scanning On” check box is identical to selecting 
“Yes/No mode” from the Input Options dialog.  When turned 
on, the program will ask questions which the student can 
answer “Yes” or “No”.

Single- and dual- switch users both may respond “Yes” in a 
number of ways:

• The “Y” key or spacebar
• The “Y” or “space” switch on an IntelliKeys standard overlay
• The “Yes” switch on an IntelliKeys or Ke:nx On:Board custom overlay
• Clicking the mouse or trackball
• Pressing the TouchWindow or one of its buttons (depending on which mode you 

have selected in the TouchWindow Control Panel)

The student responds “No” by:
 

• Pressing the “N” key or “No” switch on the input device (dual-switch users only)
• Waiting until the scan time is elapsed and the program moves on (except when 

step scanning)

Scan Rate

The scan rate is the number of seconds that the program flashes each item before scanning 
to the next item in sequential or random scanning.  The lower the number, the faster the 
program scans.

When using two switches, the scan rate can be set to 99 so that the program doesn’t actually 
scan.  Instead, the student must press the “no” switch to cause the program to change to 
the next item.

The scan rate has no effect on step scanning.
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Scanning Order

Money Skills provides 3 types of scanning.  Use the scanning order radio buttons to select the 
type of scanning most appropriate for your students.

Sequential Scanning

When sequential scanning is on, the program always scans in order from left to right, top to 
bottom or smallest to largest.  This gives the student advantage of anticipating what the next 
item will be, allowing the scan rate to be set a little lower (faster) because the student doesn’t 
need to rethink the problem after every scan.  In addition, dual-switch users can more quickly 
respond “no” using this method of scanning.

Random Scanning 

In random scanning, the program scans randomly among the items on the screen.  Some 
students will find this method more interesting.  When random scanning, the program scans 
to the “correct” item often enough that the student will not become frustrated.

Step Scanning

When step scanning, the scan rate is ignored and the student must use a second switch to 
answer “no”.  The program will scan each item until the student answers either “yes” or 
“no”.

Starting Method

Use the “Start” buttons to select the scanning start method.  Start “Immediately” means that 
the program will begin scanning automatically as soon as the problem is displayed.  

When the start “On cue” button is on, the program will present the problem, then wait until 
the student presses a switch before scanning.  While the program is waiting for the cue, it 
flashes an image like this one to signal that it is waiting:

Either starting method works with any of the three scan-
ning orders.
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Prompting and Reinforcement
Money Skills allows the teacher to custom-tailor the prompts and reinforcement that the 
program provides to best suit each student’s needs.  

Speech
Digitized speech is the key to Marblesoft’s success in helping the student to understand the 
problem that is presented and why an answer is correct or incorrect.  Much care has been 
taken to making the speech clear, informative and easy to understand.

There are three levels of speech from which to choose.  To set the speech level, choose a level 
from the Speech submenu under the Options menu.

The four levels of speech are described here:

Sassy

Sassy speech provides all the prompting and reinforcing speech of verbose (described below), 
but does it in a much more playful way.  You might not like this for certain students, but for 
others it adds a dimension of fun.  There are even a few playful insults that your students 
will find amusing, at least.  Enjoy!

Verbose

The default speech level is called “verbose”.  Verbose speech prompts the student for an 
answer, corrects mistakes and rewards correct answers.  When verbose speech is on, the stu-
dent is prompted again if an extended period of time passes without a response or if a second 
attempt at a problem is needed.

Brief

Brief speech is limited to the minimum prompting that the student needs to solve a problem.  
This option is useful when a student is using Money Skills in a setting where too much speech 
may be distracting to other students.

Off

When speech is off, audible tones are used to prompt, correct and reward the student.  These 
tones are consistent among all activities so their purpose is easily understood by the student.
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Sound Effects
Money Skills uses sound effects to prompt, correct and reward the student.  Some sound 
effects are only played when speech is set to “limited”.  Others can be turned on or off by 
the teacher.   Turn sound effects options on an off by using the Sound Effects menu under the 
Options menu.  The sound effect options are described here:

All Effects

When all effects are turned on, Money Skills plays sounds to prompt, correct and reward 
the student.

Limited

When sound effects are limited, the program plays only the sound effects that are needed to 
prompt the student for a response, and to identify whether an answer is right or wrong.

Off

When sound effects are off, Money Skills makes no sounds other than speech.

Click on Keypress

Selecting this option causes a slight “click” sound to be played whenever the student presses 
a key or switch on an input device.

Reward Sound

At the bottom of the Sound Effects menu is a list of sounds from which you can choose the 
sound that is played after a correct answer.  When you select a sound, it then becomes the 
“reward” sound for the next problem.
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Don’t Say No
When “Don’t say ‘No’” is checked on the Options menu, Money Skills does not say the word 
“no” or play the “wrong” sound after a wrong answer.  Instead, the program just displays the 
answer as usual and prompts the student to try again.  

When the check mark is off, the program will say “no” or play the “wrong” sound depending 
on the current speech and sound effect levels.

To change the “Don’t say ‘No’” option, just select it from the Options menu to toggle it on 
or off.

Repeat Prompts Delay
You can specify the amount of time that Money Skills waits for an answer before prompting 
the student again.  To do so, pull down the Options menu and select a delay from the “Repeat 
Prompts every” submenu.  The check mark indicates the current delay setting.  

Reinforcement
Money Skills can be made to display either a small rocket ship or a hot air balloon in 
the lower right corner of the screen.  To turn on this option, pull down the Options 
menu and select either the rocket or the balloon from the Reinforcement menu.

The launch pad shows the number of correct answers needed in order to reach the 
next level (see Program Control - Rate of Advancement).  

As the student answers problems correctly, the launch pad counts down.  If a wrong 
answer is given, the countdown starts over.  

When the countdown reaches 0, the ship is full of fuel and takes off.  The program 
then advances to the next level.
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Program Control
The following sections describe some other options that control the way that Money Skills 
functions.

Ignore Some Responses
In some cases, you may want the program to ignore certain responses from the student, and, 
of course, Marblesoft provides a way for you to do it!

To ignore some responses, use the Ignore submenu in the Options menu.  The three options 
are described here:

Ignore Wrong Responses

When this item is checked, the program will ignore all wrong answers.  Using this option, 
only correct answers will be responded to or recorded in the student scores.

Ignore “Stray” Responses

The default behavior is for the program to ignore any responses outside a certain range.  For 
instance, when using Coins and Bills, a stray response would be pressing a letter key.  This 
option should be used for the student who is easily distracted by the computer’s negative 
responses or the student with limited motor control who has trouble physically pressing the 
right key or switch.

Ignore None

You can also have Money Skills acknowledge all responses.  Typically, the word “No” or a 
sound effect is played after a wrong answer (see Prompting and Reinforcement - Don’t say 
“No”), and the key that was pressed is shown on the screen.  The student is then prompted 
to try again.
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Rate of Advancement
Money Skills automatically sets the level of difficulty according to the student’s scores and the 
parameters set by the teacher.  There are four settings which determine when the program 
will advance or go back a level, and when the student is shown the correct answer.

To change one of these settings, choose “Rate of Advancement...” from the Options menu 
(Mac ⌘-R, Win Ctrl-R).  A dialog box like this one will appear (Mac version shown here):

The function of the settings are described in the following para-
graphs.

Advance Rate

This is the rate at which the student will advance to a higher 
level.  If the student answers this many consecutive problems 
correct without an error, the program will automatically switch 
to the next higher level.

Backup Rate

The backup rate is how many wrong answers the program will accept before sending the 
student back to the next lowest level.

Show Answer After __ Tries

This is the number of wrong answers that you want Money Skills to accept before showing the 
student the correct answer.  When this number is reached, the student is shown the correct 
answer, then prompted to try again with the same problem.
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Fonts
You can select a font from the Font submenu in the Options menu.  That font will then be 
used for the text that the student sees on screen.  

Why would you want to do such a thing?  Well, for instance, you might want to choose 
Arial or Helvetica because they look the most like the keyboard.  Or, you might choose Times 
because the characters look like the text in a child’s book.

You can choose a script font when a child is ready to learn cursive letters, or perhaps choose 
a whimsical font just for fun.  You could also use a font-making utility to create a font from 
the student’s own handwriting!

Full Screen Mode
You can hide the menu bar by choosing “Full Screen Mode” from the Options Menu (Mac 
⌘-F, Win Ctrl-F).  The program will hide the menu bar and use as much of the screen as 
possible to make the largest possible image for the student to see.

While in full screen mode, menu shortcuts (Mac ⌘-, Win Ctrl-) still work.  To use a menu 
item that does not have a shortcut, you’ll need to exit full screen mode by typing (Mac ⌘-F, 
Win Ctrl-F) again.

Use Stop Sign
You can allow keyboard users to return to the main menu and select another 
activity by choosing “Use Stop Sign” from the Options menu.  When this 
option is on, a small stop sign icon will be drawn in the lower left corner of 
the screen.  When the stop sign is on, the student can exit the current activity 
by clicking on the stop sign or pressing the “Esc” key.

“Use Stop Sign” has no effect when the program is in yes/no mode.  When in yes/no mode, 
use the “Close Activity” command described below.

Close Activity
To exit the current activity, select “Close xxx” from the File menu (Mac ⌘-W, Win Ctrl-W) 
where xxx is the name of the activity.  The program will return to the main menu, where you 
can select a different activity.

You can also jump directly to any activity by using the following keyboard short cuts:

Mac  Win Activity
⌘-1 Ctrl-1 Coins and Bills
⌘-2 Ctrl-2 Counting Money
⌘-3 Ctrl-3 Making Change
⌘-4 Ctrl-4 How Much Change?
⌘-5 Ctrl-5 The Marblesoft Store
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Pause
Money Skills prompts the student for a response every few seconds if the student has not yet 
answered (see Prompting and Reinforcement - Repeat Prompts Delay).  In Yes/No mode, 
the program also repeats the “Yes/No” question each time it scans to a different item.  

You can temporarily turn off these prompts by selecting “Pause” from the Activity Menu 
or typing (Mac ⌘-P, Win Ctrl-P) from the keyboard.  While in pause mode, Money Skills 
continues to display the problem, but does not prompt the student again until an answer 
is given.

Use the pause mode to give the student an unlimited amount of time or when the  program is 
sitting unattended and you just want it to BE QUIET!

Quit
To quit Money Skills:

Macintosh

Select “Quit” from the File menu or type ⌘-Q.

Windows

Type Ctrl-Q, or use the Windows-standard Alt+F4.  When not in full screen mode, you can 
also choose “Exit” from the File menu or type Alt+F/X.
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Student Scores
Money Skills contains a built-in system for tracking and reporting a student’s progress.  The 
program is designed to work in conjunction with all of the programs in Marblesoft’s Early 
Learning series.  To take advantage of this feature, you should save the student files in a 
folder named “Student Scores” that is located inside the same folder as the Early Learning 
programs.  Money Skills will automatically create this folder the first time you run it.

The following sections describe student files and how to create, modify, record and report 
them.

New Student File
Before recording any scores for a student, you must create a 
student file.  Select “New Student File...” from the File menu or 
type (Mac ⌘-N, Win Ctrl-N).  When the dialog appears (Mac 
version shown), type the student’s name. 

When you click the “OK” button a dialog box like this one will 
appear to ask you for a file name:

Money Skills suggests a file name for 
the student file based on the name you 
entered.  You can make the file name any-
thing you want, although you would typi-
cally use the student’s name.  

When you are satisfied with the file name 
and the location, click on “Save” to save it 
to disk.

The program will create a new student file 
using the formatting preference you have 
specified (see Preferences).  There is no way to change the formatting of a student file after 
you create it.  To use the alternate formatting style, you’ll need to change the preference in the 
Preferences dialog, then create a new student file.
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To begin recording scores to a student’s file, choose “Open 
Student File...” from the File menu or type (Mac ⌘-O, Win 
Ctrl-O).  A dialog box will prompt you to select the student file 
you want (Mac version shown here):

Locate the student file and click on “Open”.  The program will 
open the file and automatically begin recording the scores for 
that student.  They will be recorded until the file is closed or 
until another student file is opened.

When a student file is opened, Money Skills restores all the 
program settings to what they were the last time the student 

scores were saved.  In addition, the program returns the student to the same activity and 
level that they last used.

Save Student Scores
When the student is finished with Money Skills, select “Save Student Scores” from the File 
menu or type (Mac ⌘-S, Win Ctrl-S).  The scores will be added to the student’s file.

When a student’s scores are saved, Money Skills also saves all the current program set-
tings.  These settings are then used by all Early Learning programs (version 2.1 or later).  For 
instance, if you turn scanning on and save a student file, scanning will be on the next time 
you open that student’s file in Money Skills or any other Early Learning program.

Along with the program settings, Money Skills saves the current activity and difficulty level 
for the student, so it can be restored when the student’s file is next opened.

You should only save the scores at the end of a session.  Money Skills records the scores a full 
session at a time.  If you save the scores in mid-session and again at the end, the program 
treats them as two separate sessions, making the records longer and less easy to read.

If you forget to save the scores, the program will remind you before you open another student 
file or quit.

Close Student File
To stop recording a student’s scores, select “Close Student File” from the File menu.  If there 
are any unsaved records, you will be prompted to save them before the file is closed.

Open Student File
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Reviewing Student Files
Early Learning student scores are saved in text files that can easily be opened, edited and 
printed using any typical text editor or word processor.  How you will prepare your student 
files for printing depends on the formatting option you had set in your preferences dialog (see 
Preferences) when you created the student file.

Using a word processor or spreadsheet program, you can easily create a report showing a 
single student’s progress over time, or perhaps a comparison or summary of several students.  
We’ll leave the creativity up to you.  This section describes only how to format the student 
score data.

When you open or import a student file into a word processor, it will begin with a header 
something like this:

Early Learning Student Scores

Student:  Kristi Johnson
File created 11/9/02

Format:  Tab delimited 
(or, in the case of a monospaced file...)
Format:  Monospaced

Open this file in a word processor or spreadsheet program to see the columns 
formatted correctly.

Do not modify the first six lines of this file, or the Early Learning programs may 
not be able to read it.  If you want to make changes above the dotted line, 
duplicate the file and make your changes to the copy.

----------

The first six lines cannot be modified if you wish to record any more scores to the same file.  
The preferred method is to save the file with a different name, then modify the copy.  Once 
you’ve created an editable copy, you can modify it as described on the next few pages.

The first two paragraphs show the report title, the student’s name and the date the file was 
created.  Modify these lines as you wish.

The third paragraph, beginning with “Format:” and the fourth paragraph, beginning with 
“Do not modify” are informational only, and can be deleted.

The dotted line signifies the end of the header and the beginning of the student scores.  The 
scores will be formatted differently depending on the formatting method set when the file 
was created.  The two formatting methods are described below.
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This is the default format an is the easiest to create professional-looking reports.  You can edit 
and print tab-delimited scores using any text editor, but usually you would use either a word 
processor or a spreadsheet program.

A word processor allows you to quickly format and print great looking reports.  Editing the 
scores in a spreadsheet gives you powerful formatting options plus the ability to create your 
own summary and statistical reports based on the student scores.

Both methods are described here:

Word Processor

When you open or import a student file into a word processor, the scores will usually look 
something like this:

Date:  11/8/02
Coins and Bills Attempts Right Wrong Stray No Err %No Err
  Level 1 13 13 1 0 12 92
  Level 2 17 17 2 0 15 88
  Level 3 7 6 3 2 3 43

----------

Date:  11/11/02
Coins and Bills Attempts Right Wrong Stray No Err %No Err
  Level 3 7 7 0 0 7 100
Counting Money Attempts Right Wrong Stray No Err %No Err
  Level 1 12 11 4 1 9 75

Not bad, except the columns don’t line up.  That’s because most word processors just put 
left-justified tabs every half an inch unless you specify otherwise.

What we need to do is add some right-justified tabs.  We’ll add the first one at 2.25”, then 
every .625” after that.  The tab ruler in our word processor will look something like this (this 
one’s from Adobe InDesign):

That’s all there is to it!  Removing the unnecessary information in the header, a brief note and 
a font change gives us a report that looks like the one on the next page.

Tab-Delimited
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Dear Principal Hawkins:

Here is the information you requested on Kristi Johnson.

Early Learning Student Scores

Student:  Kristi Johnson
File created 11/9/02

----------

Date:  11/8/02
Coins and Bills Attempts Right Wrong Stray No Err %No Err
  Level 1 13 13 1 0 12 92
  Level 2 17 17 2 0 15 88
  Level 3 7 6 3 2 3 43

----------

Date:  11/11/02
Coins and Bills Attempts Right Wrong Stray No Err %No Err
  Level 3 7 7 0 0 7 100
Counting Money Attempts Right Wrong Stray No Err %No Err
  Level 1 12 11 4 1 9 75

Ms. Jones
2nd Grade

Spreadsheet

When you want to import student data into a spreadsheet program for statistical summary 
and analysis, create the student files with the “tab-delimited” preference set (see Preferences).  
If you try to import monospaced data into a spreadsheet, it will all be placed into a single 
column.

To import student scores into a spreadsheet, depending on your spreadsheet program, you 
can open it directly, import it to an already open spreadsheet, or copy it from a word 
processor and paste it into the spreadsheet.

After importing the data into your spreadsheet, it looks something like this:



41

That’s not too bad.  We need to increase the width of column A a little and narrow columns B - 
G.  It would be a good idea to right-justify columns B - G also.

Here’s what our spreadsheet looks like with the above changes and a row of column totals 
at the bottom:

There it is, ready for your headings and commentary.
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Monospaced
The alternate format for student score files is the “monospaced” format.  This is useful when 
you don’t have complete control over the formatting of text and the setting of tabs, such as 
when sending e-mail or formatting Web pages (without using tables).

When you import a monospaced student score file into a word processor, the score data 
usually looks something like this:

  

Date:  11/8/02
Coins and Bills       Attempts  Right  Wrong  Stray  No Err  %No Err
  Level 1                   13     13      1      0      12       92
  Level 2                   17     17      2      0      15       88
  Level 3                    7      6      3      2       3       43

----------

Date:  11/11/02
Coins and Bills       Attempts  Right  Wrong  Stray  No Err  %No Err
  Level 3                    7      7      0      0       7      100
Counting Money        Attempts  Right  Wrong  Stray  No Err  %No Err
  Level 1                   12     11      4      1       9       75

Instead of tabs separating the columns, a monospaced contains the correct number of spaces 
between columns to line them up correctly when using a monospaced font, such as Courier.  
Monospaced fonts are fonts where every character is the exact same width, so it’s easy to 
predict how much space they will take on the page.

When formatting student scores for a Web page, use the <pre> tag around the text you want 
monospaced.  Here’s an example of some monospaced student scores formatted for HTML.  
The example is shown in Courier font.  (The <pre> and <\pre> tags are hidden by the 
browser so they won’t show on the finished Web page.)

<pre>
Date:  11/8/02
Coins and Bills       Attempts  Right  Wrong  Stray  No Err  %No Err
  Level 1                   13     13      1      0      12       92
  Level 2                   17     17      2      0      15       88
  Level 3                    7      6      3      2       3       43

----------

Date:  11/11/02
Coins and Bills       Attempts  Right  Wrong  Stray  No Err  %No Err
  Level 3                    7      7      0      0       7      100
Counting Money        Attempts  Right  Wrong  Stray  No Err  %No Err
  Level 1                   12     11      4      1       9       75
</pre>

There it is, ready to e-mail or publish on the Web.
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Preferences
Money Skills remembers most program settings when you quit the application.  All settings 
such as the currency you’re using, activity settings, input and reinforcement options and 
scanning settings are saved when you quit and restored exactly as you left them the next 
time you run the program.

There are a couple of preferences that you set from the Preferences dialog.  To set them, 
select “Preferences...” from the Edit menu.  A dialog something like this one will appear (Mac 
version shown here):

When the “Load student at startup” box is checked, the pro-
gram will bring up the “Open Student File” dialog automati-
cally every time you run the program.

The “Save student scores” buttons set which type of student 
score files will be created.  Existing student score files are not 
affected by this setting, only student files created after the 
preference is changed.
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Keyboard Shortcuts
These are some useful keyboard shortcuts in Money Skills:

Mac Windows Action
⌘-1 Ctrl-1 Coins and Bills
⌘-2 Ctrl-2 Counting Money
⌘-3 Ctrl-3 Making Change
⌘-4 Ctrl-4 How Much Change?
⌘-5 Ctrl-5 The Marblesoft Store
⌘-W Ctrl-W Close Activity and return to main menu (You can also use 

ESC if the “Use Stop Sign” option is on)

⌘-Q Ctrl-Q Quit (Windows users can also use the Windows-standard 
Alt+F4.  When not in full screen mode, you can also choose 
“Exit” from the File menu or type Alt+F/X.)

⌘-A Ctrl-A Advance a level
⌘-B Ctrl-B Back a level
⌘-L Ctrl-L Go to level
⌘-P Ctrl-P Pause

⌘-F Ctrl-F Full screen mode (or back to menu mode)
⌘-K Ctrl-K Choose currency, money options and activity options
⌘-I Ctrl-I Input options
⌘-Y Ctrl-Y Scanning options
⌘-R Ctrl-R Set rate of advancement, etc.

⌘-N Ctrl-N Create new student scores file
⌘-O Ctrl-O Open existing student scores file
⌘-S Ctrl-S Save student scores
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Technical Support
If you are having trouble with Money Skills or need help understanding some of the program’s 
features, feel free to take advantage of our free technical support.

Mail

Marblesoft Technical Support
12301 Central Ave NE 
Suite 205
Blaine, MN  55434

Phone

(763) 502-0440

If you call, please leave numbers where you can be reached both during and after normal 
business hours.  Don’t forget to leave your area code!

Fax

(763) 862-2920

E-mail

support@marblesoft.com

World Wide Web

www.marblesoft.com

Money Skills has evolved for two decades into the program it is today.  A big part of that 
evolution has been the suggestions from teachers and parents on how to make improvements 
to the program.  Please continue to make those suggestions so that Money Skills keeps getting 
better!




